Agregar IP Propia

Introduccion

En esta practica se va a agregar [P propia al sistema. Por una parte se agregara un
periférico de salida mediante una plantilla de periférico con interfaz AXI4-Lite; y por otra
parte se agregard un controlador de memoria BlockRAM (y su memoria asociada) con
una interfaz AXI4-Full.

Objetivos

Usar el asistente [P Packager para agregar IP propia

Modificar la funcionalidad de la IP creada

Agregar la IP propia al sistema

Agregar restricciones de ubicacion de pines a través de un archivo de restricciones
Agregar memoria BlockMemory al sistema.

Procedimiento

Crear IP Propia usando el asistente Create and Package IP

1. Abrir la herramienta Vivado

2. En la pantalla de inicio, en el panel Tasks presionar Manage IP y en el menu
desplegable seleccionar New IP Location. Se abrira la ventana emergente New IP
Location. Presionar el boton Next

3. En Part seleccionar la placa Arty Z7-20, en Target Languaje, seleccionar Verilog.
En Simulator Languaje seleccionar Mixed, y en IP location colocar el path
apropiado y como directorio **{path} ip. Presionar Finish** (dejar las otras
opciones por defecto y presionar OK si una ventana emergente pregunta si crear el
directorio)



Manage IP Settings

Set options for creating and generating IP. '

Part: [ Arty Z7-20 (xc7z020cig400-1) ‘:|
Target language: Verilog ~
Target simulator: Vivado Simulator ~
Simulator language: | Mixed v

IP location: Cibuffer/2c20208istemasDigitalesied_ip

Ventana IP Settings

Ejecutar el asistente Create and Package IP

1. En el menu de la parte superior, seleccionar Tools -> Create and Package New IP
2. En la ventana emergente presionar el boton Next
3. Seleccionar la opcion Create a new AXI4 peripheral y presionar Next
4. Completar los datos de la IP

Name: led_ip

Version: 7.0

Display Name: led ip vI 0

Description: Periferico de Salida

I[P Location: (dejar la ubicacion por defecto)
5. Presionar Next
6. Cambiar el nombre de la interface de S00_AXI a S_AXI

7. Dejar las otras opciones con sus valores por defecto (Lite interface, Slave mode, Data
Width: 32, Number of Registers: 4). Presionar Next

8. Seleccionar la opcion Edit IP y presionar Finish. Se abrira una nueva instancia de la
herramienta Vivado con el proyecto de la nueva IP

Crear una interfaz para los LEDs

1. En el panel sources dar doble click al archivo led_p_v1_0.v.

Este archivo tiene el codigo HDL (verilog) para la interfaz. El archivo raiz tiene un
modulo que implementa la logica para la interfaz AXI. En los respectivos directorios
tambien hay un ejemplo para leer y escribir los registros. Esta "plantilla se puede
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utilizar como base para una IP propia que utilice el bus AXI4-Lite para comunicarse
con el PS Se agregara un nuevo port para conectar los LEDs y se conectara con un
registro del bus AXI.

Desplazarse hasta la linea 7, donde esta el espacio para los parametros de usuario
(user parameters)

. Agregar en la linea 7:

parameter integer LED_WIDTH =4,

.Iralalinea 18 y agregar:

output wire [LED_WIDTH-1:0] LED,

no olvidar las comas despues de los valores o se producira un error de sintaxis

.Ir ala linea 48 e insertar:

.LED_WIDTH(LED_WIDTH),

Agregar el texto en la linea 48 y desplazar todo una linea hacia adelante (la linea
48 anterior pasa a ser la linea 49)

.Ir alalinea 52 e insertar:

.LED(LED),

Agregar el texto en la linea 52 y desplazar todo una linea hacia adelante (la linea
52 anterior pasa a ser la linea 53)

. Guardar el archivo (puede ser mediante las teclas CTRLA+S)
. En el panel sources expandir led_ip_v1_0 y abrir el archivo led_ip_vl_0_S_AXILv
. Agregar el parametro y port LED en las lineas 7 y 18 como se hizo en los pasos 2 y 3

. Desplazar hasta la linea 401 e insertar el siguiente codigo para instanciar la IP propia

(user logic)

lab3_user_logic # (
.LED_WIDTH(LED_WIDTH)

)
u1(
.S_AXI_ACLK(S_AXI_ACLK),
.slv_reg wren(slv_reg wren),
.axi_awaddr(axi_awaddr[C_S_AXI_ADDR_WIDTH-1:ADDR_LSB]),
.S_AXI_WDATA(S_AXI_WDATA),
.S_AXI_ARESETN(S_AXI_ARESETN),
.LED(LED)
)s

Estas sefiales conectan la l6gica del bus AXI con la IP propia.

10.

I1.

Guardar el archivo (puede ser mediante las teclas CTRL+S)

En el panel Flow Navigator (a la izquierda) presionar Add Sources. En la ventana
emergente seleccionar Add or create design sources. Presionar Next. En la nueva
ventana presionar Add Files y agregar el archivo lab 3_user_logic.v. Presionar OK.
Se volvera a la ventana anterior, verificar que este seleccionada la opcion Copy
sources into IP Directory y presionar Finish

Verificar el contenido del archivo y la jerarquia del disefio.



12. En Flow NAvigator presionar Run Synthesis (guardar los archivos si se pide)
13. Cuando finalice el proceso y aparezca la ventana emergente, seleccionar Cancel
Empaquetar la IP

1. En el panel Flow Navigator presionar Package IP. Aparecera una nueva pestaia
Package IP - led_ip

Packaging Steps Identification

/' dentification Vvendor xiinccom

< Compatbiliy Library: user
Name led_ip

 File Groups

Version 1.0

Customization Parameters
Display name: led_ip_v1.0

o o acess Description Periérico de Salida

/' Addressing and Memory Vendor display name
#  Customization GUI ORIt
Root directory. c/bufter/2c2020iste masDigitales/led_iplip_repoied_ip_1.0
#  Reviewand Package
Xmi file name: Digitales/led_ipip_repofied_ip_1 i
Categories
+
AX|_Peripheral

Pestaria Package IP

2. Para que la IP aparezca en el catalogo en una categoria en particular, se la debe
configurar. Presionar el signo + azul (arriba del texto AXI Peripheral ). Se abrira
una ventana emergente de categorias IP CAtegories

3. Deseleccionar la opcion AXI Peripheral y seleccionar la opcion Basic Elements y
presionar OK.

4. En la pestafia Pakcage IP - led_ip Seleccionar la opcion Compatibility (a la
izquierda). Verificar que este seleccionada la familia zynq

Packaging Steps Compatibility
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Opcion Compatibility

5. Presionar en File Groups y selecionar el enlace Merge changes from File Groups
Wizard

Packaging Steps File Groups

Merge changes from File Groups Wizard
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Esto se hace para actualizar con los cambios realizados en los archivos y el agregado
del archivo lab3_user_logic.v

6. Expandir la entrada Verilog Synthesis. Se agrego el archivo lab3_user_logic.v

7. Presionar la siguient opcion Customization Parameters y presionar el enlace
Merge changes from Customization Parameters Wizard

8. Seleccionar Customization Parameters, expandir Hidden Parameters, presionar el
boton derecho del raton sobre LED WIDTH, y seleccionar Import IP
Parameters.... En la ventana emergente presionar OK. Verificar que ahora en la
columna Customization Parameters figura LED_WIDTH

9. Verificar en la opcion Ports and Interfaces que hay creado un puertoLED

10. En la opcion Addressing and Memory se puede configurar el espacio de direcciones
que ocupa el periférico. Dejar las opciones por defecto.

11. Seleccionar la opcion Customization GUI y verificar que el parametro Led Width y
el puerto LED son visibles.

aaaaa

Show disabied ports

Customization GUI
12. Seleccionar Review and Package y verificar la ubicacion donde se creara la IP.

13. Presionar el boton Re-Package IP. En la ventana emergente presionar Yes. El
proyecto se cerrara al finalizar el proceso.

14. En la herramienta Vivado presionar File -> Close Project. Si aparece una ventana
emergente presionar OK

Agregar un repositorio al proyecto

1. Iniciar la herramienta Vivado si es necesario y abrir el proyecto del Lab2

2. Seleccionar File -> Project -> Save As... y guardar el proyecto como Lab03PS.
Verificar que este seleccionada la opcion Create Project Subdirectory y presionar
OK.

3. En el panel Flow Navigator presionar Settings.
4. En la ventana emergente expandir IP y seleccionar Repository

5. En el recuadro IP repositoriespresionar el boton "+". Navegar hasta el directorio
** ip** y presionar Select. Se abrira una ventana emergente informando que se
agrego un repositorio al proyecto. Presionar OK (Si se expande la entrada IPs se vera
que se agrego la IP led_ip_v1.0)



Project Settings
General
Simulation
Elaboration
Synthesis

1P > Repository
Add directories to the list of repositaries. You may then add additional IP to a selected
repository. I an IP is disabled then a tooktip will alert you to the reason.

IP Repositories

+ | =

Implementation

istasT cluplembedded/2018_1_zyna_labs (Project)

P
Repository
Packager

Tool Settings.
Project

Refresh All

Especificar Repositorio de IP

6. Presionar OK para cerrar la ventana emergente.

Agregar la IP propia, memoria BlockRAM y restricciones al proyecto

Agregar IP propia

1. En el panel Flow Navigator en la opcion IP Integrator presionar Open Block
Design

. En la ventana de diagrama presionar el boton derecho del raton y seleccionar add
IP... Buscar led_ip_v1.0 en el catalogo. Seleccionarla y presionar Enter para
agregarla.

. Seleccionar la IP agregada y cambiar el nombre a led_ip en el panel Block
Properties.

. Dar doble click en el bloque para abrir su configuracion (ventana emergente Re-
customize IP).

. En esta ventana se pueden modificar los parametros de la IP. Dejar las opciones por
defecto y presionar OK

. Presionar el enlace Run Connection Automation (en la parte superior). En la
ventana emergente seleccionar /led_ip/S_AXI (si no esta seleccionado) y presionar
OK.

. Presionar el boton Regenerate Layout (tercer boton de derecha a izquierda en la
pestaiia Diagram) para redibujar el diagrama.

. Seleccionar el puerto LED en la instancia led_ip presionando en su conexion,
presionar el boton derecho del raton y seleccionar la opcion Make External. Se
agregard la conexion externa LED 0[3:0]
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9. Cambiar a la pestaina Address Editor (a la derecha de Diagram) y verificar el rango
de direcciones asignados al periférico led_ip.

Agregar memoria BlockRAM

11. En la pestafia Diagram presionar el boton derecho del raton, seleccionar la opcion
Add IP, buscar BRAM vy agregar un bloque AXI BRAM Controller

12. Presionar el enlace Run Connection Automation. En la ventana emergente
seleccionar axi_bram_ctrl_0/S_AXI. Verificar que la entrada Master corresponde al
bloque M_AXI_GPO. Presionar OK

13. Dar doble click en el bloque axi_bram_ctrl_0 para configurarlo. En la ventana
emergente, en la opcion Number of BRAM interfaces cambiar de 2 a 1. Notar que
en la entrada AXI Protocol figura AXI4 en vez de AXI4-Lite, ya que la memoria
BlockRAM soporta transacciones en rafaga. Presionar OK.

14. Presionar el enlace Run Connection Automation para agregar y conectar la
memoria. Verificar que este seleccionada la opcion BRAM_PORTA. Presionar OK

15. Presionar el boton Regenerate Layout en la pestafia Diagram

16. Presionar el boton derecho del raton en el diagrama y elegir del menu desplegable la
opcion Validate Design para verificar que no hay errores. En la ventana emergente
presionar OK.
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6. En la pestafia Address Editor, verificar que el rango de axibramctrl_0 es 8K..

7. Cambiar a la pestafia Diagram y presionar el boton derecho del raton en el diagrama
y elegir del menu desplegable la opcion Validate Design para verificar que no hay
errores. En la ventana emergente presionar Rerun Validate Design. En la nueva
ventana emergente presionar OK

Agregar restricciones externas

1. En el panel Flow Navigator presionar Add Sources. Seleccionar Add or Create
Constraints. Presionar Next.

2. Presionar el boton Add Files. Navegar hasta el directorio donde esta el archivo
lab3_ArtyZ7 20.xdc y seleccionarlo. Presionar OK.

3. Presionar Finish para agregar el archivo al proyecto.

4. En el panel Sources expandir la carpeta Constraints y dar doble click al archivo
lab3_ArtyZ7 20.xdcpara ver su contenido. En este archivo esa la ubicacion de pines
y IOStandard para los LEDs verde y azul de la placa. Esta informacion esta en el
manual de la placa.



5. En la carpeta Desing Sources expandir system_wrapper/system_i(system.bd).
Presionar el boton derecho del raton sobre ese archivo y en el menu desplegable
seleccionar la opcion Generate output products. En la ventana emergente presionar
Generate. Al finalizar el proceso presionar OK en la ventana emergente.

6. En el panel Flown Navigator presionar Generate Bitstream y si aparece una
ventana emergente preguntando si guardar el proyecto, presionar Yes. Si surgen
ventanas emergentes para preguntar si se inician los procesos de Synthesis y
Implementation presionar Yes.

7. Una vez finalizados los procesos, presionar Cancel

En la siguiente practica se creara el software para controlar la nueva IP y se probara
la funcionalidad en el hardware

Conclusion

Se uso la herramienta Vivado IP packager para agregar IP propia a los repositorios. Se
integro la IP propia y memoria BlockRAM al sistema. Se agregaron restricciones
externas al sistema mediante un archivo .xdc



